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Introduction 
PneuMotion is a simulation software package that provides an accurate 
working simulation of pneumatic devices and circuits. It enables students 
to study and understand the principles of pneumatics. 

As a design tool, PneuMotion allows students to create, operate and 
observe a model circuit. The circuit can be printed, altered and improved 
as needed. 

PneuMotion contains the features of its DOS- based predecessor, but many 
elements have been redesigned to suit and utilize Windows capabilities. 

PneuMotion can be used in conjunction with the Pneuline and PneuFlex 
panels, on which actual circuits with working components can be 
assembled and operated. 
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Installation and Activation 

System Requirements 
PneuMotion requires the following: 

• Computer: IBM-compatible PC with 80486 33 MHz processor, or 
higher. 

• At least 8 MB of RAM. 

• A hard drive with at least 10 MB of free disk space. 

• Windows 95, Windows98 or Windows NT. 

• A VGA or better graphics display. 

• A Mouse or other pointing device. 

Installing the Software 
PneuMotion software is supplied on a CD-ROM together with a license 
diskette. The software is copy-protected, and you must put the license 
diskette into the computer floppy drive in order to install the software. A 
backup copy of the license diskette cannot be used. Therefore, be sure to 
keep the original license diskette in a safe place. 

To install the software, do the following: 

1. Start Windows. 

2. Close any open applications before you begin the installation. If you are 
about to reinstall the software or install a newer version to an existing 
PneuMotion directory, it is recommended that you backup any existing 
user-created files before you begin the installation. It is also 
recommended that you remove the previous PneuMotion installation by 
means of the Uninstall utility included with the software. 

3. Insert the license diskette into the computer�s floppy disk drive. Make 
sure the disk is not write-protected. 
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4. Insert the CD into the CD-ROM drive. The installation should begin 
automatically. If it does not, run setup.exe from the CD-ROM \Install 
folder. 

5. Follow the instructions that appear on the screen. 

Installing PneuMotion on a PC Without a CD Drive 
If you want to install the PneuMotion software on a PC that does not have 
a CD drive, do the following: 

Access a PC with a CD drive that is networked with the target PC, and 
follow the Installation instructions in the previous section. 

OR 

Use a PC that has both a CD drive and a floppy drive.  

• Copy all files in the PneuMotion CD's Install folder onto diskettes: 

• Each file named datan.cab (where n is a number; i.e., data1, data2) 
will fill one diskette. 

• All other files can be copied together onto a single diskette. 

• Copy all files from all the diskettes into a temporary folder on the target PC.  

• From the temporary folder, run setup.exe. 

• Follow the instructions that appear on the screen. 

You can delete the temporary directory after the installation, or you may 
keep it for reinstalling the software. 

During the software installation, messages and a percentage bar will be 
displayed on the screen to reflect the status of the installation procedure. 

You will be prompted to choose a language to install. Select a language 
from the following dialog box. 
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By default, the software is installed to the folder PneuMotion. During the 
installation process you have the option to change this. It is not 
recommended that you do so. 

When the installation is complete, the PneuMotion program group will 
appear. 

 
To preserve the display of the PneuMotion program group on the 
Windows desktop, follow the instructions in the following section. 

Keeping the PneuMotion Program Group on the Windows Desktop 
1. When the installation is complete and the PneuMotion program group 

is still active, press the backspace key once. The Programs folder 
(group) should now be displayed.  

2. Find the icon for the PneuMotion folder. Press [Ctrl], click on the 
PneuMotion icon and drag a copy of the PneuMotion folder to the 
Windows desktop. 

If the Programs folder did not appear when you pressed the backspace key, 
or if you did not place the PneuMotion program folder on the desktop at 
the end of the installation, use the standard Windows method for placing a 
program folder on the desktop, as follows: 
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1. Place the cursor on the Start button and click the right mouse button to 
open the shortcut menu. Select Open to open up the Start programs 
folder. Double click on the Programs icon to open the Programs 
folder.  

2. Find the icon for the PneuMotion folder. Press [Ctrl], click on the 
PneuMotion icon and drag a copy of the PneuMotion folder to the 
Windows desktop. 

Uninstalling the Software 
Uninstall removes all components of PneuMotion from your computer 
hard drive, and restores one user license to the installation disk. The 
software can then be reinstalled on the same computer or installed on a 
different computer. 

Before you uninstall the software, you should backup any existing user-
created program and position files. 

To uninstall PneuMotion, do the following: 

1. Insert the license diskette into the floppy drive. (Make sure the diskette 
is not write-protected.) 

2. From the PneuMotion program group, select Uninstall. 

3. Follow the instructions that appear on the screen. 

Activating the Software 
To start PneuMotion, do the following: 

1. If you will be using PneuMotion with a PneuLine or PneuFlex panel, 
make sure that all hardware has been properly set up and connected 
according to the installation procedures detailed in the user manuals. 

2. Turn on the computer and all other connected hardware. 

3. Activate Windows. 
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4. From the PneuMotion program group, select PneuMotion. 

The PneuMotion main window is displayed. 

 

Quitting the Software 
To quit PneuMotion, use any of the standard Windows methods for 
closing a program: 

• In PneuMotion, select File | Exit. 

• Double Click the Control-Menu box in the Title Bar. 

• Press [Alt]+F4. 
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Overview 

The PneuMotion Window 
The elements of the PneuMotion main window are shown in the following 
diagram: 

Menu Bar
Title Bar

Tool Bar 

Drawing Window 

Status Bar 

Menu Bar
Title Bar

Tool Bar 

Drawing Window 

Status Bar 

Title Bar

Tool Bar 

Drawing Window 

Status Bar  
 Title Bar Contains the usual Windows right-click menu 

consisting of controls for sizing and closing the 
application screen as well as an additional option 
enabling you to display the interface on top at all 
times.  

 Menu Bar Contains menus with PneuMotion commands. 
Some commands are accessible from the tool bar 
(buttons), while some are accessible only in the 
menus. 

 Tool Bar Contains buttons that represent the most frequently 
used functions and commands. Button availability 
varies according to the currently active screen or 
mode, or the selected component. 
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 Drawing Area Screen area used for designing and displaying 
circuits 

 Status Bar Displays, at the bottom of the screen, information 
regarding the PneuMotion software, modes of 
operation, current activity, and so on. When you 
position the mouse over an icon, a description of the 
icon appears in the status bar. 

File Menu 

 

The File menu contains the usual Windows functions which allow you 
to load, save and print files containing pneumatic circuit diagrams and 
connections, and to exit the software. 

Only one file can be opened and edited at a time, however you may open 
a second window to create and edit a second file. 

 New  [Ctrl]+N Opens a new, untitled file. 

 
Open  [Ctrl]+O Opens an existing file. 

 
Save  [Ctrl]+S Saves the currently active file. 

 Save As... Saves the currently active file under a new file 
name. 

 
Print  [Ctrl]+P Prints the currently active file. 

 Delete... Deletes a previously saved file. 

 Exit Quits PneuMotion. 

If changes have been made to a file, but not yet 
saved, a warning message will be displayed. 

For more information on file management, see Chapter 8. 
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Edit Menu 

 

The Edit menu contains usual Windows functions found in most 
drawing programs. These allow you to edit cross section and 
schematic diagrams. 

 Copy  [Ctrl]+C Copies a selected component to the clipboard 
as a regular drawing object. It can then be 
pasted into any other program. 

 
Duplicate Makes a copy of the selected component. 

 
Rotate Right F7 Rotates the selected component 90° to the 

right. 

 
Rotate Left Rotates the selected component 90° to the left. 

 
Mirror                 F8 Turns the selected component over from left to 

right. 

 
Flip Vertical        F9 Turns the selected component over from end 

to end. 

 
Delete  [Del] Deletes the selected component. 

 
Parameters           ! Sets values for selected components. This 

option is only available for those components 
that have variable parameters. 

For more information on editing functions, see Chapter 4. 
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View Menu 

 

The view menu contains the commands for the viewing modes 
available in PneuMotion. 

 
Cross Section Displays a cross section view of each 

component. 

 
Schematic Displays the components in standard 

schematic form. 

 
Ladder Diagram Opens a schematic control flow chart for 

electro-pneumatic circuits. 

 
Time Diagram Shows the timing (activation) of different 

components in a circuit. 

 
Zoom In Magnifies the current view. 

 
Zoom Out  [Ctrl]+Z Returns the view to normal. 

For more information on viewing, see Chapter 6. 

Components Menu 

 

The Components menu contains the commands for selecting the 
PneuMotion Component List and Library. 

 
List  [Ctrl]+F2 Opens a list of the PneuMotion components 

organized by category. 

 
Library               F2 Opens a graphic library of the PneuMotion 

components and devices. 
For more information on selecting components, see Chapter 4. 

Connections Menu 

 

The Connections menu contains the commands for connecting 
components in PneuMotion. 
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Connect Components   
F5 

Selects the Connect Components view. 

 
Delete All Connections Deletes all connections in the circuit. 

 Link PBs Links two or more push button switches 
together. 

 Clear PB Links Disconnects any PB links in the circuit. 

 
Create Ladder 
Diagram 

Creates or edits a ladder diagram for electro-
pneumatic simulations. 

For more information on making connections, see Chapter 5. 

Simulation Menu 

 

The Simulation menu contains the commands for simulating a 
pneumatic circuit, and individual components in PneuMotion. 

 
Circuit Selects the PneuMotion simulation feature. 

Simulation is available only when the Cross- 
Section display mode is active. 

 
Component Activates the simulation of a component. 

For more information on simulation modes, see Chapter 7. 

Interface Menu 

 

The interface menu contains the commands for online software 
operation. 

 Setup                  # Configures the hardware and software for 
online operation. 

 Display I/Os Proviedes graphic tracking of the inputs and 
putputs during online operation. 

 COM Test Tests communication between the hardware 
and software. 

For more information about on line operation, see Chapter 9. 
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Window Menu 

 

The Window menu defines how the windows containing circuit 
diagrams are displayed on the screen. 

 
Open Main Window Opens a new main window. 

 
Close Main Window Closes the main window if it is open. 

 
Open 2nd Window Opens a new second window. 

 
Close 2nd Window Closes the second window, if it is open. 

 Cascade The usual Windows control for resizing and 
layering open windows so that each bar is 
visible. 

 Tile The usual Windows control for resizing and 
arranging the open windows by size. 

 Arrange Icons The usual Windows control for realigning the 
icons of programs that have been minimized. 

 Close All Closes all open windows that are used for 
program editing. 

The Cascade or Tile setting remains in effect until changed. 
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Help Menu 

 

The Help menu contains commands for viewing the software version 
information as well as the software licensing options.    

 About  Opens the About Pneumotion dialog box 
containing the current software version 
information.    

 Registration  Opens the Registration dialog box enabling 
you to perform various registration options, 
such as obtain your software license by 
Intelitek�s web site, e-mail, or fax or phone.       
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Components 
The Components menu allows you to select components and include text 
in your circuit diagrams. 

You can perform the following functions on components that have been 
placed in the drawing area: 

• Move • Rotate 

• Flip • Resize 

• Delete • Copy 

Selecting Components 
To view and place components in a circuit diagram, use either of the 
following: 

• Component List dialog 

• Components Library 

The Component List 

 
Select Components | List or click the Component List button. The 
component list dialog box opens. 
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To place components from the list into the drawing area, do the following: 

1. Select a category from the Groups list. 

(If you double click on one of the category names, the component 
library [graphic display] appears). 

2. Select a component from the list. 

3. Click OK. 

4. Click on the drawing area. The component appears at the point where 
you click on the drawing area. 

The placement does not have to be exact; you can move components 
after you have placed them in the drawing area. 

You may place as many components as you need in the drawing area. 

5. Click Cancel to close the dialog box. 

The Component Library 

 
Select Components | Library, or click the Component Library button. 

The Components window opens. 

 

The components are shown either in cross section or as schematics 
depending upon the currently active display mode. 

You can move and resize the Components window, if necessary. You may 
need to use the horizontal scroll bar at the bottom of the window to find 
the component. 
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To place components from the library into the drawing window do the 
following: 

1. Click on the picture of the component you want to use. 

2. Click on the drawing area. The component appears at the point where 
you click on the drawing area. 

The placement does not have to be exact; you can move components 
after you have placed them in the drawing area. 

3. When you are finished placing the components in the drawing area, 
click anywhere in the drawing area to close the Component Library. 

Manipulating Components 
Once you have placed components in the drawing area, you can 
manipulate and arrange them. 

Click on a component to select it. 

A frame with handles is drawn around the selected component. 

 

Moving Components 
To move a component, do the following: 

1. Click on the component. A frame will be drawn around it. 

2. Click and drag the component to the desired location. 

The cursor appears as a double arrow cross while it moves the component. 
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Rotating Components 

   
To rotate a component do the following: 

1. Click on the component. A frame will be drawn around it. 

2. Select Edit | Rotate Right or Edit | Rotate Left. 
OR 

1. Select the Rotate Right, or Rotate Left button. 

2. The component is rotated 90° to the right or left. 

 
Flipping Components 

 
To flip a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Flip OR click the Flip button. 

The component is flipped over. The top and bottom sides are reversed. 

Mirroring Components 

 
To mirror a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Mirror OR click the Mirror Button. 

The component is mirrored. The left and right sides are reversed. 

Resizing Components 
To resize a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Place the mouse on one of the frame handles. 

The cursor changes to a double arrow. 

3. Click and drag the handle to readjust the size of the component. 

OR 

1. Use the + and - keys to resize the selected component. 
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Copying Components 

 
To copy a component in the circuit diagram, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Duplicate, or click the Duplicate button. 

A copy of the component appears on top of the original component. The 
duplicate component is now selected, and can be manipulated. 

You can orient, move, or resize the copied component as needed. 

The File | Copy command places the selected component on the Windows 
clipboard. This allows you to paste a component into another application 
as a graphic object. It does not make a copy of the component in the circuit 
diagram. 

Deleting Components 

 
To delete a component, do the following: 

1. Select the component you want to delete. 

2. Select Edit | Delete, or click the Delete Object button. A dialog box 
opens. 

 
3. Click Yes to delete the component. 

Adding Text 
PneuMotion allows you to add text to your circuit drawings. To add text, 
do the following: 

1. Select either the Components List or the Components Library. 

2. Select the Text object, in the list or library. 

3. Place the text object anywhere in the drawing area. 

4. Close the list or library. 

5. Select the text object, if not already selected. 
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6. To enter text in the Input Text dialog box do one of the following: 

! Press [Enter]. 

! Double click on the text object. 

7. Replace �TEXT� with the text you want to appear in the circuit 
diagram. 

 
8. Click OK. 

The text now appears as an object in the circuit diagram. You can 
manipulate it in the same way as any component. Text cannot be 
flipped horizontally or vertically. 

Component Parameters 
You can set values for the following components: 

• Double Acting Cylinder (extension and retraction time) 

• Cylinder with Roller Valve (extension and retraction time) 

• Pneumatic Delay (time interval) 

• Pneumatic Counter 

• Cylinder with Magnetic Limit Switch (extension and retraction time) 

• Timer (time) 

• Electric Counter 
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Editing Component Parameters 

 
To set the component parameters do the following: 

1. Select the component whose parameters you want to view or change. 

2. Select Edit | Parameters, or click the Component Parameters button, 
the Input Parameter dialog box opens. 

3. If more than one variable appears in the list, select the one you want to 
view or change. 

4. The current value of the selected variable is displayed. You can change 
this value by typing a new value, or by selecting a value by means of 
the scroll bar under the field. 

5. Click OK. 
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Connections 
Components and devices are connected on the screen by means of colored 
lines that represent pneumatic and electrical connections. 

Connected components cannot be rotated, flipped, or resized. They can be 
moved or deleted. 

Deleting a connected component will also delete all lines connected to it. 

Connecting Components 

Making Pneumatic Connections 

 
To connect components do the following: 

1. Select Connections | Connect Components, or click the Connect 
Components button. 

A grid of dots appears in the drawing area, indicating that components 
can now be connected. In addition, black boxes with white borders 
appear at component ports where connections can be made. 
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2. Place the mouse pointer on an available port. The border turns green, 

indicating a connection can be made. 

3. Click the mouse, a blue arrow appears indicating the first port has been 
selected. 

Optional: you may route the connection between an inlet and an outlet 
by clicking the mouse to make right angle turns along the route. A red 
line will mark the path as you create it. You can use this option to 
route lines around a component. 

4. Bring the mouse pointer to the second port. The border turns green. 

5. Click the mouse, a light blue line now connects the two components. 
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Making Electro-Pneumatic Connections 

 
Connecting electronic components is similar to connecting the pneumatic 
components. 

To connect electronic components do the following: 

1. Select Connections | Connect Components, or click the Connect 
Components button. 

Electronic components have colored circles to indicate their sockets. 
Red sockets are live. Blue sockets are ground. 

On switches and relays, red sockets are normally closed, black 
sockets are normally open, and blue sockets are common. 

2. Place the mouse pointer on the first socket, the socket turns green 
indicating a connection can be made. 

3. Click the mouse, a light blue arrow now appears, indicating a socket 
has been selected. 

4. Bring the mouse pointer to the second socket. The socket turns green. 

The path will be indicated by an aqua line as you drag the mouse to the 
second port. 

Optional: you may route the connection between sockets. Click the 
mouse to make right angle turns along the path. Aqua-colored lines 
mark the path as you create it. You can use this option to route lines 
around a component. 

 
5. Click the mouse. The line turns red, indicating the connection has been 

made. 
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Deleting one Connection 
To delete a connection, do the following: 

1. Place the mouse pointer on the line you want to delete. Do not click. 
The connection will blink and change color. 

2. Press [Del], the connection will be deleted. 

Deleting All Connections 

 
To delete all of the connections do either of the following: 

• Select Connections | Delete All Connections. 
OR 

• Click on the Delete All Connections button. 

All connections are deleted. 

Erasing an incomplete Connection 
To erase a partially complete connection, press [Del]. 

The line is deleted. 

Changing the Second Port of a Connection 
To change an existing connection, do the following: 

1. Place the mouse on the line you want to delete. The connection will 
blink and change color. 

2. Click on the line you want to change. 

3. The line changes color. The second port is disconnected while the first 
port remains selected. 

4. Click on the port you want for the new connection. 

The new connection is displayed. 

Exiting the Connections Window 

 
To exit the Connections window do either of the following: 

• Click on the Close Connections button. 

OR 
• Press [Esc]. 

The dot grid disappears and you can perform other operations on your circuit 
diagram. 
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Linking Push Buttons 
For safety reasons, a pneumatic circuit may require simultaneous (two 
handed) operation of two push buttons. Since you can only click one 
button at a time, the push button link option allows you to simulate  
simultaneous, two-handed, activation of the push buttons. 

Push button links can be made only when the Cross-Section display mode 
is active. These links cannot be made when the Connections or Schematic 
mode is active. The links can be removed, however when any display mode 
is active. 

To link two push buttons, do the following: 

1. Select Connections | Link PBs. 

You are prompted to select the master push button. The master is the 
push button that controls both push buttons. 

2. Click on the PB that you want to serve as the master. 

The letter M is now displayed inside the component. 

You are prompted to select the slave push button. The slave is the push 
button that is controlled by the master. 

3. Click on the push button that you want to serve as the slave. 

The push buttons are now a linked pair, as indicated by an identical 
digit (e.g., M1 and S1) 

 
Whenever you activate the master push button, the slave button is also 
activated. However, the slave push button remains operable on its own. 

Disconnecting One Pair of Linked Push Buttons 
To disconnect the links between a selected pair of push buttons, do the 
following: 

1. Select Connections | Link PBs. 

Lines appear showing all pairs of linked push buttons. 

2. Place the mouse pointer on the line you want to delete. Do not click. 

3. Press [Del], the connection will be deleted. 
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Disconnecting All Push Button Links 
To disconnect the links between all push buttons Select Connections | 
Clear PB links. 

All push button links are removed. 

Ladder Diagrams 

Creating a Ladder Diagram 

 
You can make electro-pneumatic connections by means of a ladder 
diagram. 

To create a ladder diagram, do either of the following: 

• Click on the Edit Ladder Diagram button. 

OR 

• Select Connections | Create ladder Diagram. 

The Create Ladder Diagram window opens. 

 

Component Table 

Rung 

Make 
Connection. 
(Will turn black 
when 
connection is 
made). 
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Creating a Circuit from a Ladder Diagram 
The Create Ladder window has two parts. The top half shows the ladder 
diagram, the bottom half shows a table of electro-pneumatic components. 
(Components whose names appear in black have been placed in the 
drawing area and can be connected in a circuit). 

To connect components by means of the ladder diagram, do the following: 

1. Click on a black component in the table. 

2. The cell will turn white, and the cursor changes to a boxed +. 

3. Click on the ladder diagram rung where you want to place the 
component. 

4. The component now appears in the ladder diagram. 
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Use the buttons at the top of the window to make, change or delete the 
connections. 

 
 

Checks the connections. 

If a connection or component turns red the 
connection is faulty. If nothing happens, the 
connection is OK. 
Although the connections test is successful the 
actual components on the panel may not be 
properly connected. 

 
 

Connects Components.When selected, the cursor 
turns into a wand. 

Black lines indicate a connection. Click on the blue 
lines to turn them black (connect). 

 
 

Deletes components or connections. When selected, 
the cursor truns into a wire cutting tool. 

Place the cursor on the connection or component 
you want to delete, and click. 

 
 

Moves a rung in the ladder diagram down one line. 
When selected, the cursor turns into a shaded 
square. 

Place the cursor on the rung you want to move, and 
click. The rung moves down one line. 

 
 

Saves the connections made in the ladder diagram 
and exits to the main window. 

 
 

Closes the Create Ladder Diagram window without 
saving the new connections. 

Any connections made in the ladder diagram will 
not appear in the circuit diagram. 
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Views 
The View menu allows you to select the view in which the components are 
displayed. Two basic display modes are available: 

• Cross-Section 

• Schematic 

The Zoom In and Zoom Out options can be used when either display mode 
is active. 

In addition, the view menu allows you to display two types of diagrams: 

• Ladder Diagram 

• Time Diagram 

Cross Section Display 
The Cross-Section display mode provides a cross-section illustration of the 
components, as shown in the picture at the right. The different colors allow 
you to see airflow of each component. 

 
The cross-section allows you to observe the following: 

• Operation of the circuit and components. 

• Simulated air pressure flowing through the connections and its effect 
on the various components. 

• The component�s reactions to changes in pressure. 
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Activating the Cross-Section Display Mode 

 
To display the Cross-Section mode, do either of the following: 

• Select View | Cross-Section. 

OR 

• Click on the Cross Section Button. 

Schematic Display 
The Schematic option displays the components in standard schematic form, as 
shown in the picture at right. This display mode is useful for observing and 
analyzing components in a pneumatic circuit or complex system. 

 
The Schematic display mode is for viewing purposes only. Simulation or 
connections cannot be performed in this mode. 

Activating the Schematic Display Mode 

 
To display the Schematic Mode, do either of the following: 

• Select View | Schematic. 

OR 

• Click on the Schematic button. 
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Zoom 
In PneuMotion you can zoom in to see a section of the circuit diagram better. 

Zoom In 

 
To zoom in do the following: 

1. Select View | Zoom In, or Click on the Zoom in Picture button. 

2. The Choose Screen dialog box opens. 

 
3. A rectangle is attached to the cursor. Move the rectangle to select the 

part of the screen you want to enlarge, and click the mouse. 

Zoom Out 

 
To Zoom out do the following: 

• Select View | Zoom Out. 

OR 

• Click on the Zoom Out Picture button. 

The circuit diagram returns to its normal view. 

Selected 
Zoom area 
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Time Diagram 
The time diagram shows the status of a component at different times 
during circuit operation. It helps you to determine whether a component is 
receiving conflicting signals. 

 

Activating the Time Diagram 

 
To view the time diagram, do one of the following 

• Select View | Time Diagram | Display. 

OR 

• Click on the Time Diagram button. 
To view a new time diagram, do one of the following: 

• Select View | Time Diagram | New. 

OR 

• Click on the Time Diagram button. 
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To change which push button the time diagram will start with do the 
following: 

1. Select View | Time Diagram | Start With. 

The Select Push Button for Start Timing Diagram dialog box appears. 

2. From the list, select the push button with which the timing will start. 

3. Click OK. 

 

Ladder Diagram Display 
A ladder diagram is a schematic control flow chart for electro-pneumatic 
circuits. It is automatically generated by the software according to 
electrical connections you make in the diagram. 
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Displaying the Ladder Diagram 

 
To display the ladder diagram of the circuit diagram in the currently active 
window, do either of the following: 

• Select View | Ladder Diagram. 

OR 

• Click on the Display Ladder Diagram button. 

The Ladder Diagram window opens. 

 

Closing the Ladder Diagram 

 
To close the ladder diagram, click on the Exit Ladder Diagram button, or 
use any standard Windows method for closing a window. 
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Simulation 
The simulation mode allows you to observe the operation of a component 
working independently or as part of a whole circuit. 

Simulation is available only when the Cross-Section display mode is in 
effect. 

Single Component Simulation 
You can simulate the operation of any single component displayed in 
cross-section. There are two options available for single component 
simulation. 

• Automatic step by step. This simulation displays continuously 
changing states of the selected component. This is the default setting. 

• Manual step by step. This simulation shows each state of the selected 
component one at a time. You must continuously click the component 
to display each state. 

Simulating a Component Automatically 

 
To automatically simulate operation of a single component, do the 
following: 

1. Select the component you want to simulate. 

2. Select Simulation | Component | Automatic Stepped. 

OR 

1. Click the Single Component Simulation Auto Stepped Button. 

Simulating a Component Manually 
To manually simulate operation of a single component, do the following: 

1. Select the component. 

2. Select Simulation | Component | Manual Stepped. 



User Manual 48 PneuMotion  
0212  Simulation Software for Pneumatics 

3. Click on component to change the state of the component. 

Stopping the Simulation of Single Components 

 
Exit the simulation mode to make changes in the curcuit diagram. 

To stop the component simulation, click on Exit from Single Component 
Simulation button. 

The normal viewing mode is resumed. 

Circuit Simulation 

 
PneuMotion allows you to simulate the operation of an entire circuit. 

To view the simulation of an entire circuit do one of the following: 

• Select Simulation | Circuit. 

OR 

• Click on the Simulate Circuit button. 

Once you are in the simulation mode, you can click on any push button 
that is in the diagram to see how they will effect the pneumatic circuit. 

When you have finished viewing the simulation, you must return to normal 
mode. 

Stopping the Circuit Simulation 

 
To stop the circuit simulation, click on the Exit from Simulate Circuit 
button. 

The normal viewing mode is resumed. 
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File Management 
PneuMotion files are managed through the standard Windows file tools, 
found in the File menu. 

 New           [Ctrl]+N Opens a new, untitled file. 

 

 
Open       [Ctrl]+O Opens a dialog box for selecting an existing circuit 

diagram file. 

 
Save          [Ctrl]+S Saves the currently active file. 

If the file is untitled, a dialog box opens for defining 
the file name. By default, the system provides a file 
name (e.g. PN0031.BIN). You may give the file any 
title you want. 

 



User Manual 50 PneuMotion  
0212  Simulation Software for Pneumatics 

 Save As Saves the currently active file under a new file 
name.  

The Save File dialog box opens. Enter a new name 
in the Title field. By default the system provides a 
file name (e.g., PN0031.BIN). 

 
Print           [Ctrl]+P Prints the currently active file. 

 Delete... Opens a dialog box with a list of previously saved 
files. 

Choose a file that you want to delete and click OK. 

 
 Exit Quits PneuMotion. 

If changes have been made to a file, but not saved, a 
warning message is displayed. 
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System Setup 

Program Windows 
The Window menu contains Windows commands for the display of the 
program windows. 

 
Open Main Window Opens a new main window. 

This command functions the same as File | New. 

 
Close Main Window Closes the active main window. If changes have 

been made, but not yet saved, a warning message 
will be displayed. 

The button toggles between open and close. It opens 
a window if one is not currently active, and closes a 
window if one is currently active. 

 
Open 2nd Window Opens a new second window. 

The second window will open under the main 
window. It functions in the same way as the main 
window. It can be moved and resized. 

Only the main and 2nd windows can be open at the 
same time in PneuMotion. 

 
Close 2nd Window Closes the active second window. If changes have 

been made, but not yet saved, a warning message 
will be displayed. 

The button toggles between open and close. It opens 
a window if one is not currently active, and closes a 
window if one is currently active. 

 Cascade The usual Windows control for resizing and 
layering open windows so that each title bar is 
visible. 
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 Tile The usual Windows control for resizing and 
arranging the open windows by size. 

 Arrange Icons The usual windows control for realigning the icons 
of programs that have been minimized. 

 Close All Closes all open windows that are used for program 
editing. 

The Cascade or Tile setting remains in effect until changed. 

Online Operation 
PneuMotion can be used to control actual electro-pneumatic circuits and to 
provide graphic tracking of the PneuLine and PneuFlex laboratory panels. 

The CP/C 2000A computerized programmable controller is required for 
the software-hardware interface. 

Refer the documentation provided with the panel and the CP/C 2000A for 
installation instructions. 

Configuring the Software for Online Operation 
To configure the software for online operation, do the following: 

1. Make sure the computer, the panel, the CP/C 2000A and the power 
supply are all properly connected. 

2. Use PneuMotion to load or draw an electro-pneumatic circuit, which is 
(or will be) assembled on the PneuLine or PneuFlex panel. 

The figures below show the same circuit drawn in PneuMotion and, set 
up on the PneuLine panel. 
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3. Select Interface | Setup. 

The Setup dialog box opens. This box allows you to select the 
components that are controlled and tracked by the software. 

 
All electrical input and output connections made in the circuit diagram 
are available in the Setup dialog box. 

4. Using the check boxes, select the components that will operate online. 

Once components are selected online operation, they respond to 
external I/O signals only. PneuMotion graphically tracks the 
operation of these components (and does not simulate their operation). 
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Software Licensing 
In software version 1.5 (and higher), the licensing process has been 
changed to enable you to obtain your software license directly from 
Intelitek�s web site. 

In previous software versions the user obtained the software license from 
the license diskette that was provided with the software.  

This chapter describes how to register the PneuMotion software and 
includes the following:  

 
• Registering the Software from Intelitek�s Website  

• Registering the Software from the License Diskette 

Registering the Software from 
Intelitek�s Website 

The software is protected by a licensing agreement. Once installed, you 
can use the fully operational software for a 30-day evaluation period. To 
continue using the software after this period, you must obtain an unlock 
code from Intelitek.  

To obtain an unlock code, complete the following steps: 

1. Install the software from the CD.  

2. Send the CD key and the PC-specific code to Intelitek. 

3. Upon receipt of the unlock code, enter it in the Registration dialog 
box. 
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The sections below provide detailed instructions on how to use the 
software license. 

• Register your software and receive a PC-specific unlock code for each 
license purchased. 

• Protect your license. 

• Transfer a license from one PC to another PC. 

• Return a license to Intelitek, in order to retrieve it later. 

• Frequently asked questions. 

Registering the Software and Receiving an Unlock Code 
During the software installation, you will be prompted to enter the CD 
key. This number can be obtained from the CD case. (Note: It is 
recommended to keep the CD key in a safe place).  

The installation procedure generates a PC-specific code. This code can be 
obtained from the Registration dialog box that is displayed by selecting 
Help | Registration from the main window. 

In order to receive the unlock code for the software you installed, you 
must send Intelitek both the CD key and the PC-specific code.  

The Registration dialog box provides several options for obtaining the 
unlock code (automatically from Itelitek�s website, by email or by fax or 
phone). Each option is described below.  

Registering the Software Automatically (from Intelitek�s 
Website)  

If you have internet access you can obtain your unlock code automatically 
from Intelitek�s website.  

To obtain the unlock code automatically from Intelitek�s website:  

1. In the registration dialog box select Get Unlock Code and then select 
From Intelitek.com. The CD Key dialog box is displayed. 

2. Enter the CD key in the displayed dialog box. The software will 
automatically connect to Intelitek�s website. The unlock code will 
automatically be installed on your PC and you will see a message that 
the software is now licensed. 
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Registering the Software by E-mail  
You can use Intelitek�s software licensing service to obtain the unlock 
code by e-mail. 

To obtain the unlock code by e-mail: 

1. In the Registration dialog box, select Get Unlock Code and then select 
By Email.  

2. If email is available on the PC, a new e-mail message containing all 
required details will open enabling you to perform the following:  

• Fill in the requested user information (optional) 

• Click Send. The licensing service will send back an unlock code. 

• Enter the unlock code in the Registration dialog box and select 
Unlock. 

3. If you have email service, but not on the same computer on which the 
software is installed, a Notepad window containing all required details 
will open enabling you perform the following: 

• Fill in the requested user information (optional), and then transfer 
the text/file to your email program.  

Send to:   info@intelitek.com 
Subject line: Intelitek Software License  

To ensure automatic processing, use this exact subject line and do 
not edit the automatically generated text in the message. You may 
add text and comments to the end of the message.  

• Once you receive the unlock code, enter it in the Registration 
dialog box and select Unlock. 

Registering the Software by Fax or Phone   
When you have no Internet or e-mail services available, you can register 
your software by fax or by phone.   

To obtain the unlock code by fax or phone:  

1. Select Get Unlock Code and then select By Fax or Phone. A Notepad 
window containing all required details will open. 

2. Fill in the requested user information (optional), and then print out the 
document. 

3. Contact your local dealer or Intelitek with the printed information. 
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Protecting Your License 
Every unlock code is unique. It will become invalid (and cause the 
software to stop functioning) when you change a physical component in 
your PC (e.g., hard disk, network card, CPU), format your disk, or install a 
new operating system. However, if you want to upgrade your PC and keep 
your software operational, you can transfer the license (meaning, the 
unlock code) to another PC. After you have upgraded your system, 
reinstall the software (if necessary) and transfer the license back. 

If you do not have a PC available for the temporary transfer operation, 
return the license to Intelitek. You will be able to retrieve the license by 
following the standard procedure for obtaining the unlock code.  

Transferring a License  
This section describes how to transfer a license from one PC to another 
and is used for example when upgrading your system.   

To transfer a license from one PC (source) to another PC (target): 

1. On the target PC install the software and obtain the PC-specific code 
from the Registration dialog box. 

2. On the source PC, open the Registration dialog box. Enter the PC-
specific code of the target PC and then select Transfer. The software 
on the source PC will generate a new unlock code for the target PC and 
will remove the license from the source PC. 

3. On the target PC, enter the new unlock code in the Registration dialog 
box. 

Returning a License to Intelitek  
This section describes how to return and retrieve a license to and from 
Intelitek. This procedure is used when you are required to remove a 
software license but you do not have a target PC available    

To return/retrieve a license: 

1. From the Registration dialog box, select the Remove the License 
option and then click Remove. The software will generate a unique 
Remove code. 

2. Send the Remove code and your CD key to Intelitek using one of the 
methods described above (email, website, fax/phone). We will 
confirm the codes and update our licensing registration records.  

3. When you are ready to retrieve your license, install the software (if 
necessary) and follow the instructions for obtaining an unlock code. 
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FAQs - Frequently Asked Questions 
What is a CD key? 
This is the code on a label on the CD. It allows Intelitek to track software 
that has been purchased. 

What do I do if I do not have a CD key? 
When prompted to enter the CD key during the software installation, enter 
the word �evaluation�. This will allow you to install the software for a trial 
period. 

What is a PC-specific code? 
This is a code generated by the software. It is unique for each PC and each 
installation of the software. This code allows Intelitek to generate the 
unlock code for the PC on which you installed the software. The PC-
specific code is displayed in the Registration dialog box. 

What is an unlock code? 
This is a code that allows you to use the software after the evaluation 
period expires. You need to send your CD key and PC-specific code to 
Intelitek. We will reply with the unlock code for the software you 
purchased. 

How do I install and register the software on more than 
one PC? 
Repeat the procedure for obtaining an unlock code as many times as 
necessary. 

Alternately, install the software on all PCs and make a note of the PC-
specific code generated on each PC. You can then send us one email or fax 
listing all the PC-specific codes. You will receive unlock codes for each 
PC. (Note: this will be handled manually by our technical support and 
may take several days). 

Why should I give you my personal details when I 
request the unlock code? 
This will allow us to keep you informed about products, upgrades and 
services available for your system and software. It will also allow us to 
help you in case of a lost license. 

How can I recover the unlock code after a disk crash or 
other system failure? 
Once you have restored and reactivated your PC, reinstall the software. If 
it resumes operation in Evaluation mode, follow the procedure for 
obtaining an unlock code. Include a comment explaining why you need a 
new unlock code. (Note: this will be handled manually by our technical 
support and may take several days). 
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How can I extend the evaluation period? 
The 30-day evaluation period begins as soon as the software is installed. 
Reinstalling the software on the same PC will not renew the evaluation 
period. 

Under certain circumstances we will extend your evaluation period. Use 
the Get unlock code option in the Registration dialog box to request a 
time extension. Be sure to send us your CD key, PC-specific code, and the 
reason for your request.  

After approving your request we will send you an unlock code that will 
extend the evaluation period.  

When you receive the unlock code, perform the following: 

1. Enter it in the Registration dialog box. 

2. Select the Extend the Evaluation Period option. 

3. Select Unlock. 

Registering the Software from 
the License Diskette  

During the PneuMotion software installation, a copy-protection shield is 
also installed on the hard disk. Only one installation per hard disk is 
permitted. The shield includes a counter which is updated each time the 
software is installed (and uninstalled). 

To verify the number of remaining installations: 

1. Insert the license diskette into the floppy drive, and execute the file 
WINSDEI.EXE. This opens a dialog box. 
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2. Select the required option, as follows: 

! Check: Select this option to see how many installations are still 
available. The Check Remaining Software Installations dialog box 
is displayed.   

 
After installing the software from a disk that is licensed for a single 
installation, the Check counter will indicate 0 installations 
remaining. 

If you uninstall the software, one user license is restored to the 
original software disk, thus permitting the software to be 
reinstalled on the same another computer.   

! Install: If a message appears indicating that PneuMotion does not 
detect the license, select this option to transfer a license from the 
installation disk to the hard disk.  

! Remove: If you uninstall PneuMotion, but a license has not been 
restored to the original installation disk, select this option to 
transfer the license from the hard disk back to the installation disk.  
(Make sure the disk is not write-protected.) 

 


